Basic PC Know How Booklet

Computer overview
- Component functions and parts of a desktop PC
- Keyboards, mice and cables

Qld Health Desktop
- Folders. Applications, Task bar, Icons
- File System functions

One Drive
- Office 365

Outlook
- Emailing

Web browsers
- Internet Explorer, Microsoft Edge

Tips and Tricks
- Outlook, Word, Excel

Teams

Education LibGuide
Basic Computer (PC)

Information Book

Many people use desktop computers at work, home, and school. There are two types of computers, Windows based (Left picture) and Apple Mac (Right picture). Desktop computers are designed to be placed on a desk, and they're typically made up of a few different parts.

![Desktop PC](image1) ![Apple computer & MacBook](image2)

**Desktop computer** - The basic parts of a desktop computer, Personal Computer (PC) are the computer case, monitor, keyboard, mouse, and power cord. Each part plays an important role whenever you use a computer. The computer case is the metal and plastic box that contains the main components of the computer, including the motherboard, central processing unit (CPU), and power supply. The front of the case usually has an On/Off button. Computer cases come in different shapes and sizes. A desktop case lies flat on a desk and the monitor usually sits on top of it. A tower case is tall and sits next to the monitor or on the floor.

The monitor works with a **video card**, located inside the computer case, to display images and text on the screen. Most monitors have **control buttons** that allow you to change your monitor's display settings. Newer monitors usually have **LCD** (liquid crystal display) or **LED** (light-emitting diode) displays. These can be made very thin, and they are often called **flat-panel displays**.

The keyboard is one of the main ways to communicate with a computer. There are many different types of keyboards, but most are very similar and allow you to accomplish the same basic tasks.
The **mouse** is another important tool for communicating with computers. Commonly known as a **pointing device**, it lets you **point** to objects on the screen, **click** on them, and **move** them. There are two main mouse types: optical and mechanical. The **optical** mouse uses an electronic eye to detect movement and is easier to clean. The **mechanical mouse** uses a rolling ball to detect movement and requires regular cleaning to work properly.

**Buttons and Ports on a Computer**

Each computer is different, so the buttons, ports, and sockets will vary from computer to computer. However, there are certain ones you can expect to find on most desktop computers. Learning how these ports are used will help whenever you need to connect something to your computer, like a new printer, keyboard, or mouse. Thebelow images are of the common desktop PC’s that you will see in our work environment.

**Desktop PC (micro)**

1. Power Button
2. Optical Drive (Optional)
3. Universal Audio Jack
4. USB Ports
5. USB Type A
6. SD Media Card Reader (Optional)
7. USB Type C
8. Line-out
9. Keyboard Port
10. Mouse Port
11. Display Ports (HDMI)
12. USB Type A
13. USB Type A
14. PCIe card Slots
15. Release Latch
16. Serial Port
17. Video Port (Optional)
18. RJ-45 (Earth net)
19. Slots for Wireless Antennas
20. Power Connection
This is a selection of cables that may be used to connect various items to the PC, such as Projectors, Speakers, Video Conferencing equipment etc.
The back of a computer case has connection ports that are made to fit specific devices. The placement will vary from computer to computer, and many companies have their own special connectors for specific devices. Some of the ports may be colour coded to help you determine which port is used with a particular device.
The very first step is to **turn on** the computer. To do this, locate and press the **power** button. It's in a different place on every computer, but it will have the universal power button symbol.

Once turned on, your computer takes time before it's ready to use. You may see a few different displays flash on the screen. This process is called **booting up**, and it can take anywhere from 15 seconds to several minutes.

You interact with a computer mainly by using the **keyboard** and **mouse**, or a **track pad** on laptops. Learning to use these devices is essential to learning to use a computer. Most people find it comfortable to place the keyboard on the desk directly in front of them and the mouse to one side of the keyboard.

### Communication with the computer using the Keyboard

There are a number of layouts of the keyboard.

In a QWERTY layout the keys are arranged in the same order as that of a typewriter. This is called QWERTY because the keys **Q-W-E-R-T-Y** occur on the left top row of the keyboard.

The keys in this type of keyboard can be grouped into following five types:

1. **Function keys** – F1 to F12 are programmable keys used as short cut keys to perform certain functions. 
2. **QWERTY keys** – alphanumeric keys arranged in same order as that of typewriters. 
3. **Special purpose keys** – Tab, Caps lock, Shift, Ctrl, Alt, Esc, Backspace, Enter, Print Scrn, Scroll Lock and Pause/Break are special purpose keys. 
4. **Numeric pad keys** – separate section in the keyboard used for entering numeric data. 
5. **Cursor control keys** - these are used to navigate the cursor on the monitor.

1: Have a good look at your keyboard. The image below is a colour coded keyboard layout.

![Keyboard Layout](image)

Some keyboards, especially those on laptops, will have a slightly different layout. For example, they may not have a number pad or the delete key may be in a different place. Practically all keyboards will have these significant keys somewhere.

2: The main keys are the letter keys. When you type just using these, you get lower-case print. However, if you hold down a ‘shift key’ (there are two to choose from) at the same time as you type, you’ll get **UPPER-CASE** letters. Open a Microsoft word document using the Microsoft word application.

Try typing your name, including capitals (UPPER-CASE) and spaces. The ‘space bar’ (which you press briefly to make a space) is the wide key at the bottom of the keyboard.

3: If you make a mistake in your typing, there’s always a remedy.

To delete a letter, place your cursor (mouse pointer) just after the letter and click. Then press Backspace briefly. (Always press briefly – otherwise, you’ll get repeated deletions, spaces, letters or whatever.) Or place your cursor just before the letter, click and press Delete.
4: Now try typing a sentence:

“I know it is wet and the sun is not sunny, but we can have lots of good fun that is funny.”

5: You can move the cursor along this sentence without deleting anything by using the arrow keys:

Try moving the cursor backwards and forwards through your sentence using the arrow keys.

6: Now try using the number pad.

To use this to type numbers, you must press the Num Lock key. There may be an indicator light at the top of the keyboard or on the ‘Num Lock’ key itself to show that it’s on.

7: You can also type using the numbers on the main keyboard. You’ll find them on the row of keys above the top line of letters.

Above these numbers are various symbols, which include ‘£’, ‘&’, ‘!’. To use these, hold down the Shift key while you type. So if you press ‘7’ on its own, you get ‘7’, but if you press ‘7’ while you hold down the ‘Shift’ key, you get ‘&’. Try typing: Last night I won $2,475,638 on the lottery & I am having a “Massive” party! ☺

You’ll find similar extra symbols elsewhere on the keyboard:

They operate in the same way as the ones above the numbers.
Step 8: If you want everything to appear in upper case, press the Caps Lock key and then type:

**I CAN TYPE CAPITALS**

Again, an indicator light may come on to show that your capitals are ‘locked’. Don’t forget to press this key again when you’re finished to turn ‘Caps Lock’ off.

Along with the keyboard, the mouse is the main way of telling your computer what you want it to do.

The mouse controls the **pointer** on the screen. Whenever you move the mouse across the desk, the pointer will move in a similar manner.

The pointer can appear on the monitor as a pointer, a hand or a text cursor symbol.

**Mouse Basics: Left vs. Right Click**

The standard mouse has two buttons, plus a scroll wheel in the middle that sometimes is a button. But most mice do just two things: right- and left-click.

Left-click is often referred to as “normal-click” or “regular-click.” Most tasks on a computer can be accomplished solely through using the left mouse button. Pressing the left mouse button seems to simulate the mouse cursor being pressed down on the screen: you can drag items or select text or open files.

A double-click is a special type of left-mouse-button click which is getting used less and less. A double-click is usually used for opening files on your computer, where a single-click is used for navigating webpages.

The right mouse button is one of the most valuable tools on the computer. It’s not strictly defined as having a function which makes it hard to describe, but the basic purpose of the right mouse button is this: to give you information *about* what you’re clicking on.

If the left mouse button directly interacts with an object, the right mouse button often allows you to indirectly interact. Right-clicking a file gives you a list of things to do with the file, or the option to see its properties. Right-clicking your desktop background allows you to modify the desktop. Right-clicking a link allows you to do other things with that link besides visit it.
**Right-click menu**

Use the right-click

Take full advantage of the right-click any time you highlight text or want to view the properties of an object. For example, if you highlight a file or text, you can right-click that highlighted item, copy it, and then right-click anywhere else to paste it.

**Tip:** If you highlight or select any file or text and then click and drag while holding the right mouse button, when you let go an option to move or copy that file is shown. This saves you the extra step of having to right-click where you want to paste the item.

**Tip:** While in a browser, pressing and holding Ctrl while clicking on any link opens a menu with options for that link.

---

**Function of Mouse Scroll Wheel Button**

You are now that familiar with using the mouse for pointing, clicking, dragging. The computer mouse also has, beside the buttons for left click and right click a scrolling wheel that has a special function.

The scroll wheel is used to “scroll” up or down on a document, web page etc. Other functions of button click on the Scroll wheel:

When you are opening a document that contains multiple pages, or opening a website, to view the page up or down, simply by clicking / pressing the scroll wheel button of the mouse, then move the mouse up or down (depending on needs), then the display of the page will automatically move by itself. The speed when you move the mouse will affect the speed, fast or slow displaying movement of the page.

Another function of the scroll wheel button is to open a hyperlink address, when the link is clicked using the scroll wheel button, the link will automatically open in a New Tab, so we do not need to keep right clicking then choose open link in new tab. Just one click using the scroll wheel button.

Zoom in and Out on a web page, word document, excel spreadsheet, etc. by holding down the Ctrl key and scrolling up to zoom in and down to zoom out.

Hold down the Shift key and scroll down in most Internet browsers to go back to the previous web page.

---

**Ergonomic mice examples**
The Desktop

The main screen you'll start from is the desktop, as pictured below. This is like a main menu or a table of contents for the computer. From here, you can access programs and features you need to use in the computer.
**What are Icons?** They are used to represent the different files, applications, and commands on your computer.

An icon is a small image that's intended to give you an idea at a glance of what it represents, like a logo.

Double-clicking an icon on the desktop will open that application or file.

![Icons on a computer desktop](image)

**When you open an application or folder,** it is displayed in its own window. A window is a contained area—like a picture within a picture—with its own menus and buttons specific to that program. You can rearrange multiple windows on the desktop and switch between them.

No matter which operating system you use, your computer uses folders to organize all the different files and applications it contains. **Folder icons** on your computer are designed to look like file folders full of documents or pictures.

![Folder icons](image)

Each operating system has its own file system, which helps you find your folders and files. If you have a Windows PC, like QLD Health, you'll use the **File Explorer** (also known as **Windows Explorer**). If you have a Mac, you'll use **Finder**.

Here, we'll talk about the basic functions that are common to all computer file systems.
Opening your computer's file system

File Explorer icon looks like a folder, as in the image below and is located within the search menu, you can pin it to your task bar for easier access.
On a Mac, the **Finder icon** looks like a face on the Dock, as in the image below.

In both operating systems, you can also open the file system by **clicking a folder** from your **desktop**.

### Navigation

Whether you're using Windows Explorer or Finder, basic navigation will work the same way. If you see the file you want, you can double-click it with your mouse. Otherwise, you can use the Navigation pane on the left side of the window to select a different location.

---

**OneDrive** for Business is a place where you can store and share your work files. As part of Office 365, OneDrive for Business lets you update and share your files from anywhere, and work on an Office document with others at the same time.

All files that you store in OneDrive for Business are private, unless you decide to share them. You can share files with specified co-workers to collaborate on projects. You can also share with people external to Queensland Health.
Using OneDrive

You can work with the files you store in OneDrive for Business directly from Word, Excel, PowerPoint, or any other Office desktop application without the need to go to your Office 365 browser.

To save a file to OneDrive for Business, from your open document <click> File > Save As > and choose ‘OneDrive – Queensland Health’, browse to the location where you want to save the file, and then click Save.

To open a file that resides in OneDrive for Business, in the Office desktop app <click> File > Open > and choose ‘OneDrive – Queensland Health’, browse to the location where you saved the file, select it and then click Open.

Share documents in OneDrive

OneDrive for Business is your document library in Office 365. Files you store in OneDrive for Business are private by default unless you decide to share them.

To share your document with nominated colleagues or external people, <click> the Share button in the top right-hand corner of an Office Application and enter their names in the Invite people dialog box or full email address for external people then <click> Share.

Access OneDrive from a Shared PC via the Office 365 application

Double click onto the Office 365 application, a popup sign in box will appear. Enter your Qld Health email and click Next.
Another sign in page will appear, enter your password in here to complete the user authentication.

Welcome to the QH Federation Service.
Sign on using your primary email address and password

leana.barby@health.qld.gov.au
Password

Sign in

The web browser will display as below, you can access OneDrive as well as various other applications within office 365.
Microsoft Outlook

Now that you are familiar with communicating with the PC and have a basic knowledge of the various applications, we will now run-through emailing using the Microsoft Outlook application.

What is E-mail?
E-mail is a message that may contain text, files, images, or other attachments sent through a network to a specified individual or group of individuals.

Writing an e-mail

When writing an e-mail message, it should look something like the example window below. Several fields are required when sending an e-mail:

1. The To field is where you type the e-mail address of the person who will be the receiver of your message.
2. If you are replying to a message, see Image 1, the To and From fields are automatically filled out; if it's a new message, you'll need to enter them manually.
3. The CC or Carbon Copy field, see Image 2 allows you to send a copy of the message to another e-mail address, but is not mandatory.
4. The Subject Line, see Image 1, although not required, should consist of a few words describing the e-mail's contents.
5. Finally, the Message Body is the location you type your main message. It often contains your signature at the bottom; similar to a hand-written letter, see Image 2.

You can access the outlook application via the icon in the Search Menu. If you have pinned it to the task bar you can access the app there too.

Outlook can also be accessed via Office 365.

However, you access the application you double click on the icon to open it.
Using the Address Book

If you need to send an email to a person or a group of persons, you will need to access the Global address list that contains all of the Qld Health email addresses.

Step 1
Click on the New Email icon to generate an email message.
Step 2
Click on the To icon, this will open up the Global Address list.

Type the email recipient's name into the search bar. When you have the person that you want to email you can double click on the highlighted blue name or single click on the To icon then click the OK icon.

Once you have clicked OK your email will then be displayed again for you to add additional information.
Email Message Options

You can change the “Importance” level of a message to identify to the receiver that there may be a time frame attached or an action that may be required from them in relation to the email.

To do this right click on the “High Importance” icon

If you receive an email that has been flagged as “High Importance” this is how it will appear in your email account
Web Browsers - Internet Explorer and Microsoft edge

Internet Explorer is the most widely used World Wide Web browser. When you open either of the browsers it will automatically open to Qld Health’s home page which is called QHEPS.

From QHEPS you can also access QLD Health Policies, Procedures and Guidelines as well as some of the QH Applications.

When using Office 365 the default browser is Microsoft Edge

Notice the difference in appearance between the two web browsers:

**image 1 - Internet Explorer**

**Image 2 - Microsoft Edge**
Tips and Tricks

Outlook, Word, Excel & Teams

Keyboard shortcuts…

<table>
<thead>
<tr>
<th>All - Pressing this</th>
<th>Does This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Cancels an action</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo last action</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Re-do last action</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut selected item</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Close document</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste into document</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Underline selected text</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save document</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word - Pressing This</th>
<th>Does This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+R</td>
<td>Right align selected text</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open new document</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Left align selected text</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Italicize selected text</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Center selected text</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected item</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Bold selected text</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl+I [</td>
<td>Increase font size 1 point</td>
</tr>
<tr>
<td>Ctrl+[</td>
<td>Decrease font size 1 point</td>
</tr>
<tr>
<td>Alt+W then Q</td>
<td>Opens the Zoom tool</td>
</tr>
<tr>
<td>Alt+Q</td>
<td>Go to “Tell me what you want to do”</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Outlook Pressing This</th>
<th>Does This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escape or Enter</td>
<td>Close item</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected message, task, or meeting</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected item</td>
</tr>
<tr>
<td>Alt+S</td>
<td>Send message</td>
</tr>
<tr>
<td>Ctrl+Shift+M</td>
<td>New message</td>
</tr>
<tr>
<td>Ctrl+Shift+K</td>
<td>New task</td>
</tr>
<tr>
<td>Ctrl+Shift+A</td>
<td>Create appointment</td>
</tr>
<tr>
<td>Ctrl+E Alt+H then R then P</td>
<td>Search</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>Go to calendar</td>
</tr>
<tr>
<td>Alt+S then S</td>
<td>Send and Receive</td>
</tr>
<tr>
<td>Alt+N then A then F</td>
<td>Insert file</td>
</tr>
<tr>
<td>Alt+JA then A then S</td>
<td>Attachment Save As</td>
</tr>
<tr>
<td>Alt+H then R then P</td>
<td>Reply</td>
</tr>
<tr>
<td>Alt+H then R then A</td>
<td>Reply All</td>
</tr>
<tr>
<td>Alt+H then M then V then select folder from list</td>
<td>Move to folder</td>
</tr>
<tr>
<td>Alt+H then F then W</td>
<td>Forward</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Go to Home tab</td>
</tr>
</tbody>
</table>
**Excel - Pressing This**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+B</td>
<td>Bold selected item</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected item</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open a workbook</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save a workbook</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste selected item</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Close a workbook</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut selected item</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo last action</td>
</tr>
<tr>
<td>Delete key</td>
<td>Remove cell contents</td>
</tr>
<tr>
<td>Alt+A</td>
<td>Go to Data tab</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Go to the Home tab</td>
</tr>
<tr>
<td>Alt+H then A then C</td>
<td>Center align cell contents</td>
</tr>
<tr>
<td>Alt+H then B</td>
<td>Add borders</td>
</tr>
<tr>
<td>Alt+H then D then C</td>
<td>Delete column</td>
</tr>
<tr>
<td>Alt+H then H</td>
<td>Choose a fill color</td>
</tr>
<tr>
<td>Alt+M</td>
<td>Go to Formula tab</td>
</tr>
<tr>
<td>Alt+N</td>
<td>Go to Insert tab</td>
</tr>
<tr>
<td>Alt+P</td>
<td>Go to Page Layout tab</td>
</tr>
<tr>
<td>Alt+W</td>
<td>Go to View tab</td>
</tr>
<tr>
<td>Ctrl+0</td>
<td>Hide the selected columns</td>
</tr>
<tr>
<td>Ctrl+9</td>
<td>Hide the selected rows</td>
</tr>
</tbody>
</table>

**Outlook**

Create an email message template

Use email templates to send messages that include information that infrequently changes from message to message. Compose and save a message as a template, and then reuse it when you want it. New information can be added before the template is sent as an email message.

1. On the **Home** tab, click **New E-mail**.

**Keyboard shortcut**  
To create an email message, press CONTROL+SHIFT+M.

In the message body, enter the content that you want.

1. In the message window, click the **File** tab.
2. Click **Save As**.
3. In the **Save As** dialog box, in the **Save as type** list, click **Outlook Template**.
4. In the **File name** box, type a name for your template, and then click **Save**.

By default templates are saved in the following location:

`c:\users\username\appdata\roaming\microsoft\templates`
Use an email message template

To use an email message template, use the following steps:

2. In the Choose Form dialog box, in Look In, click User Templates in File System.
3. The default templates folder is opened. The folder location (in Windows 7 and later operating systems) is \users\username\appdata\roaming\microsoft\templates. If your template is saved in a different folder, click Browse, and then select the template.
4. Select the template, and then click Open.
5. Make any additions or revisions to the recipients in the To, Cc, or Bcc boxes and any changes to the subject and message body.

Note: Changes made aren’t saved to the template. If you use the Save command, this creates a draft of your message, but won’t update the template. To update the template, follow the steps for saving a new template in Create an email message template.

6. Click Send.

Flagging Messages

- Flagged email messages help you better manage your mail.
- Flagged messages create to-do items either for you alone or for you and the recipients of the email message.
- For example, you can flag an email message that requests information that you need by a certain date.

Flag to remind recipients to follow up

When you must have a timely response to a message, use a flag for the recipients.

1. Before you select Send, on the Message tab, in the Tags group, select Follow Up, and then select Custom.
2. Select Flag for Recipients.
3. Under Flag for Recipients, select a flag in the Flag to list.
4. By default, a reminder accompanies the task. To send a flag without a reminder alert, clear the Reminder check box.

The flag text that recipients receive appears in the InfoBar.
Flag to remind you to follow up

If you must follow up on a message that you are about to send, set a reminder for yourself.

1. Before you select Send, on the Message tab, in the Tags group, select Follow Up.
2. Select a flag for when you want to be reminded about this message.

By default, the following flag start dates, due dates, and reminders are available:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Start date</th>
<th>Due date</th>
<th>Reminder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today</td>
<td>Current date</td>
<td>Current date</td>
<td>One hour before the end time of today's work day</td>
</tr>
<tr>
<td>Tomorrow</td>
<td>Current date plus one day</td>
<td>Current date plus one day</td>
<td>Start time of current day plus one work day</td>
</tr>
<tr>
<td>This Week</td>
<td>Current date plus two days, but no later than the last work day of this week</td>
<td>Last work day of this week</td>
<td>Start time of current day plus two work days</td>
</tr>
<tr>
<td>Next Week</td>
<td>First work day of next week</td>
<td>Last work day of next week</td>
<td>Start time of the first work day of next week</td>
</tr>
<tr>
<td>No Date</td>
<td>No date</td>
<td>No date</td>
<td>Current date</td>
</tr>
<tr>
<td>Custom</td>
<td>Current date</td>
<td>Current date</td>
<td>Current date</td>
</tr>
</tbody>
</table>

Alternately, select Custom to create a Start date and Due date that doesn’t appear on the list. Select OK to close the dialog box.

The flag text that recipients receive appears in the InfoBar.

Note: If you want to customize the flag by specifying Start and Due dates or change when the reminder alert appears, follow the steps in the Flag to remind you and recipients to follow up section. You can clear the Flag for Recipients check box to customize flags that only you see.

Tracking completed messages

When you remove or clear a reminder or flag, you lose any indication the message was ever a to-do item. If you want an indicator that you’ve completed the action required for a flagged message, mark it complete instead. The flag becomes a check mark. In Tasks, you can change the view to see all completed items (until the item is deleted).

1. In the message list, click the message.
2. Right-click the flag.

3. Click Mark Complete.

**Flag a message that you receive**

You can flag a message that you receive to remind yourself to follow up or take action later. To flag a received message, do one of the following:

- In the message list, select the flag column next to the message.
  
  Unless you have changed the default flag, the flag uses today's date for the **Start date** and **Due date**.
  
- In the message list, right-click the flag column next to the message. Select the due date for the task.

  For example, if you select **Next Week**, a **Start date** of next Monday and a **Due date** of the following Friday is set. Select **Custom** to use a **Start date** and a **Due date** that don't appear in the list.

After you select **OK**, the flag text appears in the InfoBar.

Flagged messages appear in the To-Do Bar, in Tasks, and in the Calendar Daily Task List.

By default, the following flag options are available.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Start date</th>
<th>Due date</th>
<th>Reminder</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Today</strong></td>
<td>Current date</td>
<td>Current date</td>
<td>One hour before the end time of today's work day</td>
</tr>
<tr>
<td><strong>Tomorrow</strong></td>
<td>Current date plus one day</td>
<td>Current date plus one day</td>
<td>Start time of current day plus one work day</td>
</tr>
<tr>
<td><strong>This Week</strong></td>
<td>Current date plus two days, but no later than the last work day of this week</td>
<td>Last work day of this week</td>
<td>Start time of current day plus two work days</td>
</tr>
<tr>
<td><strong>Next Week</strong></td>
<td>First work day of next week</td>
<td>Last work day of next week</td>
<td>Start time of the first work day of next week</td>
</tr>
<tr>
<td><strong>No Date</strong></td>
<td>No date</td>
<td>No date</td>
<td>Current date</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>Current date</td>
<td>Current date</td>
<td>Current date</td>
</tr>
</tbody>
</table>
Use ‘Tell Me What You Want to Do’

If you are trying to find a function on Microsoft Word but are struggling to navigate the menus or can’t remember the shortcut, click the ‘Tell me what to do’ shortcut at the top of the toolbar ribbon.

From here, you can type in the action you’d like to perform, and you’ll get contextual answers to take advantage of. For example, typing ‘create a table’ will give you some options for creating a table from within your Word document.

This tool is something that many old school Word users may not even know exists, but it’s incredibly useful.

Select Text Quickly

You already know that double-clicking will select a single word, however, triple-clicking will select an entire paragraph. If you want to select an entire sentence, press the CTRL key and click on a word within the sentence. If you want to select a rectangular block of text, press the ALT key and drag your mouse to select the area.

Change the Case

Select a part of the document and press Shift+F3 to change the case of the selection. This alternates to change the case to uppercase, lowercase, or camel case while you’re typing a document.

Use Word’s Calculator

There’s a hidden calculator in Microsoft Word. Find Quick Access Toolbar in the Word Options and switch to All Commands then add the Calculate Command to the Quick Access Toolbar. Once you’ve enabled the calculator, write your math expression in the document, select it, and press the Calculator button to view the results in the status bar.

Use the Built-In Thesaurus

There’s a built-in thesaurus on Microsoft Word. If you’re looking for a synonym, highlight the word and press Shift+F7 to view a variety of synonyms.
Quickly Replace Multiple Mistakes

Have you just finished a lengthy document and just noticed you made a small mistake for a word, for example, writing land mark, instead of landmark? You can fix this within a few seconds by using find and replace.

First, press Ctrl+F and the find and replace tool will open. Next, click on Replace, then type in the word or phrase you want to replace. After, type the contents you’d like it be replaced by.

Quickly Copy and Create Lists

Let’s say you need to go through a document and pick out certain words/phrases and create a list from them.

Instead of going back and forth, writing each item onto the list each time you see a word, you can simply highlight each word and press CTRL + F3. You can do this multiple times, until you have found each word/phrase.

Once you are finished, go to the area in the document you’d like the list to be created and press Ctrl + SHIFT + F3 to paste all of the highlighted areas you’ve just copied. This feature is known as Spike in Word.

As a final step, you can then highlight the contents and use the bullets or numbering tools in the toolbar to turn the words/phrases into a more ordered list.

Delete Words With One Key Press

Need to delete a big chunk of text? Instead of holding down the backspace bar, you can instead hold CTRL and then press BACKSPACE.

Doing this will delete one word each time you press the backspace button, instead of just one character. Hold down the backspace button and the ctrl button together to delete chunks of text at lightning speed

Excel

One Click to Select All

You might know how to select all by using the Ctrl + A shortcut, but few know that with only one click of the corner button, as shown in the screenshot below, all data will be selected in seconds.
Input Values Starting with 0

When an input value starts with zero, Excel will delete the zero by default. Rather than reset the Format Cells, this problem can be easily solved by adding a single quote mark ahead of the first zero, as shown.

![Image showing Excel cell with single quote mark]

Rename a Sheet Using Double Click

There are multiple ways to rename sheets, and most users will right click to choose Rename, which actually wastes a lot of time. The best way is to just click twice, then you can rename it directly.

![Image showing sheet tabs]

Filtering data

Filters can be applied in different ways to improve the performance of your worksheet. You can filter text, dates, and numbers. You can even use more than one filter to further narrow your results.

1. Begin with a worksheet that identifies each column using a header row.

Worksheet with header row
2. Select the **Data** tab, then locate the **Sort & Filter** group.

3. Click the **Filter** command.

**Clicking the filter command**

4. Drop-down arrows will appear in the header of each column.

5. Click the **drop-down arrow** for the column you want to filter. In this example, we'll filter the Type column to view only certain types of equipment.

**Filtering a column**

6. The **Filter** menu appears.

7. **Uncheck** the boxes next to the data you don't want to view or uncheck the box next to **Select All** to quickly uncheck all.

8. **Check** the boxes next to the data you do want to view. In this example, we'll check Laptop and Projector to view only these types of equipment.
Selecting filter data

9. Click **OK**. All other data will be filtered, or temporarily hidden. Only laptops and projectors will be visible.

**Filtered worksheet**

<table>
<thead>
<tr>
<th>ID #</th>
<th>Type</th>
<th>Equipment Detail</th>
<th>Checked Out</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Laptop</td>
<td>10” Saris Netbook Pro</td>
<td>04-Oct-10</td>
</tr>
<tr>
<td>4</td>
<td>Laptop</td>
<td>10” Saris Netbook Pro</td>
<td>29-Sep-10</td>
</tr>
<tr>
<td>5</td>
<td>Laptop</td>
<td>15” EDI SmartPad L200-3</td>
<td>15-Sep-10</td>
</tr>
<tr>
<td>6</td>
<td>Laptop</td>
<td>15” EDI SmartPad L200-3</td>
<td>14-Aug-10</td>
</tr>
<tr>
<td>7</td>
<td>Laptop</td>
<td>15” EDI SmartPad L200-3</td>
<td>08-Aug-10</td>
</tr>
<tr>
<td>8</td>
<td>Laptop</td>
<td>15” EDI SmartPad L200-4X</td>
<td>26-Sep-10</td>
</tr>
<tr>
<td>9</td>
<td>Laptop</td>
<td>17” Saris X-10 Laptop</td>
<td>04-Oct-10</td>
</tr>
<tr>
<td>10</td>
<td>Laptop</td>
<td>17” Saris X-10 Laptop</td>
<td>19-Sep-10</td>
</tr>
<tr>
<td>11</td>
<td>Laptop</td>
<td>17” Saris X-10 Laptop</td>
<td>24-Sep-10</td>
</tr>
<tr>
<td>12</td>
<td>Laptop</td>
<td>17” Saris X-10 Laptop</td>
<td>25-Aug-10</td>
</tr>
<tr>
<td>26</td>
<td>Projector</td>
<td>Omega VisX 1.0</td>
<td>28-Sep-10</td>
</tr>
<tr>
<td>27</td>
<td>Projector</td>
<td>Omega VisX 1.0</td>
<td>26-Sep-10</td>
</tr>
<tr>
<td>28</td>
<td>Projector</td>
<td>Omega VisX 1.0</td>
<td>22-Aug-10</td>
</tr>
</tbody>
</table>

Filtering options can also be found on the Home tab, condensed into the **Sort & Filter** command.
To add another filter:

Filters are additive, meaning you can use as many as you need to narrow your results. In this example, we’ll work with a spreadsheet that has already been filtered to display only laptops and projectors. Now we'll display only laptops and projectors that were checked out during the month of August.

1. Click the drop-down arrow where you want to add a filter. In this example, we'll add a filter to the Checked Out column to view information by date.

2. Uncheck the boxes next to the data you don't want to view. Check the boxes next to the data you do want to view. In this example, we'll check the box next to August.

Selecting filter data

3. Click OK. In addition to the original filter, the new filter will be applied. The worksheet will be narrowed down even further.

Worksheet with two filters
To clear a filter:

1. Click the drop-down arrow in the column from which you want to clear the filter.
2. Choose Clear Filter From.

Clearing a filter

3. The filter will be cleared from the column. The data that was previously hidden will be on display once again.

To instantly clear all filters from your worksheet, click the Filter command on the Data tab.

Teams

Teams are a collection of people, content, and tools surrounding different projects and outcomes within an organization.

- Teams can be created to be private to only invited users.
- Teams can also be created to be public and open and anyone within the organization can join (up to 5000 members).

A team is designed to bring together a group of people who work closely to get things done.

Conversations, files and notes across team channels are only visible to members of the team.

Channels are dedicated sections within a team to keep conversations organized by specific topics, projects, disciplines—whatever works for your team!
Files that you share in a channel (on the Files tab) are stored in SharePoint.

Channels are places where conversations happen and where the work actually gets done. Channels can be open to all team members or, if you need a more select audience, they can be private.

Standard channels are for conversations that everyone in a team can participate in and *private channels* limit communication to a subset of people in a team.

**Team roles**

There are two main roles in Microsoft Teams:

- **Team owner** - The person who creates the team. Team owners can make any member of their team a co-owner when they invite them to the team or at any point after they’ve joined the team.
  - Having multiple team owners lets you share the responsibilities of managing settings and membership, including invitations.

- **Team members** - The people who the owners invite to join their team.

**Team settings**

Team owners can manage team-wide settings directly in Microsoft Teams. Settings include the ability to add a team picture, set permissions across team members for creating standard and *private channels*, adding tabs and connectors, @mentioning the entire team or channel, and the usage of GIFs, stickers, and memes.

**Convert an outlook calendar appointment into a Teams appointment**

- Open the Outlook appointment
- Click onto the Teams Meeting icon in the message tool bar
  - The Teams link will be inserted into the message body
- Add names of the persons that are required to participate into the meeting into the address bar.
• Advise participants that they need to have downloaded the Teams application onto their device prior to the meeting

• The meeting invitation will display in Outlook and in Teams. Participants click on the ‘Join Microsoft Teams Meeting’ link to open the Teams application to join the meeting.

The Teams dialogue window will display as below, participants click onto the ‘Join Now’ button.
The Education Libguide is a live online tool that you can access at home and at work to view and complete your Mandatory Training requirements. Now that you have a basic understanding on how to successfully navigate and communicate using the PC go to the Libguide to view Mandatory Training requirements.

From a personal PC you can gain access to the Education Libguide by entering the following URL (Uniform Resource Locator) into the address bar of an internet page. You can either free text type or copy and paste it.

URL: http://sas.health.qld.libguides.com/pdmt

To access the Education Libguide from a QLD Health PC follow the below instructions

- Open a QHEPS intranet page
- Select (left click) Organisational Structure

URL:

http://sas.health.qld.libguides.com/pdmt
From the Community and Oral Health Intranet page, select ‘Training and Education.’

Then select ‘Libguides’

This is the Education Libguide
When you click on the various pages across the top of the LibGuide it will open and display the content within that page.

Further information and Fact Sheets can be located on QHAPS, link below...

View the videos by clicking on the video links below...

eihealth Queensland